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Introduction 

This document has been written to help both visually impaired and sighted users to type math content within Microsoft 

Word without needing to search for symbols and functions within Word’s equation toolbar. The math content created 

with this tool can be read aloud with the JAWS screen reader. 

Opening Microsoft Word’s native equation tool 

Microsoft Word’s equation tool can be accessed within a Word document by selecting the Insert menu and then 

selecting Equation, or alternatively by pressing ALT + EQUALS. 

Typing math content using the toolbar (sighted users) 

After selecting Insert and Equation or the shortcut ALT + EQUALS, an equation box appears within Word so that the 

student can type in the content. An equation toolbar also appears at the top of the screen, as shown below. 

 

Sighted students can use a combination of regular keystrokes (numbers, letters, the plus symbol, etc.) along with 

additional mathematical symbols found in this equation toolbar. Alternative keystrokes are described later in this 

document for visually impaired users or for sighted users who would prefer to type commands rather than to navigate 

to the toolbar. (See “Keystrokes for common math symbols and functions.”) 

Exiting the equation tool 

If you are typing math content on a line by itself using the equation tool and are finished typing content for that line, 

simply press enter to go to the next line. By default, Word will no longer be in equation mode. If you want to type 

another equation on the next line, press ALT + EQUALS or Insert + Equation again. 



If you are done typing inline math content within a sentence and wish to type normal text after the math content, press 

the right arrow to exit the math content and to be in text mode again. Then press the spacebar key to create a space 

between the math content and your next word, and type the rest of your sentence as usual. 

Keystrokes for common math symbols and functions (Jump to list of keystrokes.) 

Microsoft Word’s equation toolbar contains so many pulldowns and symbol choices that it is unfortunately difficult to 

navigate with a screen reader. Below are some common symbols and functions, in alphabetical order, that can be 

utilized by those who are sighted or visually impaired instead of navigating the equation toolbar. All of the commands 

below are used AFTER pressing ALT + EQUALS, which opens Word’s equation tool and creates a box to enter the 

mathematical input. (Make sure that you also read the instructions above on how to exit the equation tool to resume 

typing regular text.) The list below is not exhaustive; to find additional commands, see the section entitled, “Discovering 

other equation tool commands.” If the commands below are not working for you, see the “Troubleshooting” section at 

the end of the document. 

List of keystrokes and commands, in alphabetical order 

A 

Angle symbol: \angle followed by spacebar. 

alpha (lowercase): \alpha followed by spacebar 

B 

beta (lowercase): \beta followed by spacebar 

C 

chi (lowercase): \chi followed by spacebar 

Composition of functions (small circular symbol): type \circ followed by spacebar. (Note that the JAWS screen 

reader reads this symbol as “ring operator.”) 

Congruence symbol: \cong followed by spacebar 

Cosecant function: csc followed by spacebar, followed by the content you want to type within the function 

(remember parentheses if needed), followed by the right arrow to exit the cosecant function to type more math 

content. 

Cosine function: cos followed by spacebar, followed by the content you want to type within the function (remember 

parentheses if needed), followed by the right arrow to exit the cosine function to type more math content. 

Cotangent function: cot followed by spacebar, followed by the content you want to type within the function 

(remember parentheses if needed), followed by the right arrow to exit the cotangent function to type more math 

content. 

Cube root: \cbrt followed by spacebar, followed by the content that you want included inside the cube root, 

followed by spacebar. 

• To obtain √𝑥3 , type \cbrt followed by spacebar followed by x. 

• To obtain √𝑥 + 5
3

, where you want the x + 5 inside the cube root, you must use parentheses: Type \cbrt 

followed by spacebar, followed by (x+5), followed by spacebar. 

• To obtain √𝑥 + 5
3

+ 3, where you want the x and the 5 inside the cube root and the + 3 outside the cube 

root: Type \cbrt followed by spacebar, followed by (x+5), followed by spacebar, followed by +3. 



D 

Degree symbol: \degree followed by spacebar 

Note that no superscript command is necessary. Type 30\degree then spacebar to produce the output 30°.  

delta (lowercase): \delta followed by spacebar, produces the output 𝛿. 

Delta (uppercase): \Delta followed by spacebar, produces the output Δ.  

Division symbol: To create a division symbol that looks like a horizontal line with a dot above and below, type \div 

followed by spacebar (see Fractions to create a fraction). 

E 

Element of: \elementof followed by spacebar 

Empty set: \emptyset followed by spacebar 

epsilon (lowercase): \varepsilon followed by spacebar, or \epsilon followed by spacebar. These commands produce 

the output 𝜀 and 𝜖, respectively. 

Equals sign: Use the keyboard equals sign, =. 

Exponents/Superscripts: Use the caret key followed by the desired exponent followed by spacebar. (Remember 

parentheses in the exponent if it contains more than one term.) 

• 3𝑥2 + 1 is typed as: 3x^2, then spacebar, then +1. 

• 2𝑥+1 is typed as: 2^(x+1) then spacebar. 

F 

Fourth root: \qdrt followed by spacebar, followed by the content that you want included inside the fourth root, 

followed by spacebar. 

• To obtain √𝑥4 , type \qdrt followed by spacebar followed by x. 

• To obtain √𝑥 + 5
4

, where you want the x + 5 inside the fourth root, you must use parentheses: Type \qdrt 

followed by spacebar, followed by (x+5), followed by spacebar. 

• To obtain √𝑥 + 5
4

+ 3, where you want the x and the 5 inside the fourth root and the +3 outside the fourth 

root: Type \qdrt followed by spacebar, followed by (x+5), followed by spacebar, followed by +3. 

Fractions: To create a fraction, use the forward slash key, and press the spacebar key when you are done typing the 

denominator. 

• The fraction ¼ can be typed with 1, then /, then 4, then press spacebar. 

• To type 
𝑥+1

𝑥+3
 , you must type parentheses around the numerator and denominator, i.e., (x + 1), then /, then 

(x+3), then spacebar. 

• To type 
3

5𝑦
 , type 3, then /, then 5y, then spacebar. (You can type parentheses around the denominator, 5y, 

which results in the same output.) 

• To type 
3

5
𝑦, type 3, then /, then 5, then spacebar, then y. 

G 

gamma (lowercase): \gamma followed by the spacebar 

Greater than or equal to symbol: \ge or \geq followed by the spacebar. Alternatively, simply press the > key 

followed by the = key. (Note: To type a greater than symbol, simply use the > key on the keyboard.) 



H 

Hyperbolic trigonometric functions: Hyperbolic sine, hyperbolic cosine, and hyperbolic tangent can be written as 

sinh, cosh, and tanh. Hyperbolic secant, cosecant and cotangent are written as sech, csch, and coth. Each of these 

commands sholud be followed by the spacebar, followed by the content within the function (remember 

parentheses), followed by the right arrow to exit the hyperbolic function in order to type more math content. 

I 

Infinity: \infty followed by spacebar 

Note: To type negative infinity, type a dash before the infinity command, i.e. -\infty followed by spacebar 

Integers symbol: See “Set of integers symbol.” 

Integrals:  

For indefinite integrals (integrals without lower and upper limits), type \int followed by spacebar, followed by the 

content that you want included inside the integral. Example: ∫ (𝑥2 + 1)𝑑𝑥 is typed as \int followed by spacebar 

followed by (x^2+1)dx. 

For definite integrals (integrals with lower and upper limits), type \int followed by an underscore symbol followed by 

the lower limit, then followed by the caret key along with the upper limit. Example: ∫ (𝑥2 + 1)𝑑𝑥
7

3
 is typed as 

\int_3^7 (x^2+1)dx. If you type the math content on its own separate line, the integral symbol will be larger as 

shown below: 

∫ (𝑥2 + 1)𝑑𝑥
7

3

 

Intersection symbol: \cap followed by spacebar 

Inverse Trigonometric Functions:  

To obtain the inverse sine, inverse cosine, or inverse tangent functions, type arcsin, arccos, or arctan – where each 

one should be followed by a spacebar.  

To obtain the inverse cosecant, inverse secant, or inverse cotangent functions, type arccsc, arcsec, or arccot – where 

each one should be followed by a spacebar. 

K 

kappa (lowercase): \kappa followed by spacebar 

L 

lambda (lowercase): \lambda followed by spacebar 

Less than or equal to symbol: \le or \leq followed by the spacebar.  Alternatively, simply press the < key followed by 

the = key. (Note: To type a less than symbol, simply use the < key on the keyboard.) 

Limits: You can type the word lim with an appropriate subscript as shown with the example below; pay attention to 

the spaces as they are necessary for proper display and reading with the JAWS screen reader. To obtain 

lim
n→∞

(n2 + 1), type lim_(n \rightarrow \infty ) (n^2 +1) 

Logarithms:  

To type the common logarithm (base 10), type log followed by spacebar, followed by the content you want to type 

within the function (use parentheses if needed), followed by the right arrow to exit the logarithm function to type 

more math content. 

To type the natural logarithm, type ln followed by spacebar. 



To type logarithms with other bases, type log followed by the underscore key, followed by the value representing 

the base, followed by spacebar, followed by other content. For example, log3(𝑥 + 1) + 4 can be obtained by typing 

log_3 (x+1), then the right arrow, then +4. 

M 

Minus symbol: use keyboard dash/minus sign, - 

mu (lowercase): \mu followed by spacebar 

Multiplication symbol: To create a multiplication symbol that looks like an x (and is read by the JAWS screen reader 

as “times”, type the backslash symbol followed by the word times, i.e. \times followed by spacebar. If you want a 

dot multiplication symbol, you can type \cdot, but note that JAWS screen reader will read it as “dot operator” 

instead of “times.” 

N 

Natural numbers symbol: See “Set of natural numbers symbol.” 

Not equal to: \ne or \neq followed by spacebar 

O 

omega (lowercase): \omega followed by spacebar, produces the output 𝜔. 

Omega (uppercase): \Omega followed by spacebar, produces the output Ω. 

P 

Parallel symbol: \parallel followed by spacebar 

Perpendicular symbol: \perp followed by spacebar 

phi (lowercase): \varphi or \phi – each of which is followed by spacebar, produces the output 𝜑 and 𝜙, respectively. 

pi (lowercase): \pi followed by spacebar 

Plus symbol: use keyboard plus sign, + 

Plus or minus symbol: Simply press +-, or alternatively type \pm followed by spacebar. 

Prime symbol: Press the apostrophe (single quote) key followed by spacebar, or type \prime followed by spacebar. 

R 

Rational numbers symbol: See “Set of rational numbers symbol.” 

Real numbers symbol: See “Set of real numbers symbol.” 

rho (lowercase): \rho followed by spacebar 

Right Arrow: \rightarrow followed by spacebar, or \to followed by spacebar, or simply type -> (a dash followed by 

the greater than symbol). 

Roots: See Square roots, Cube roots, Fourth roots for details on those functions. Roots other than square roots, 

cube roots, and fourth roots cannot be typed manually into Word’s equation tool. (You can alternatively select 

Insert + Equation, then choose the “Radical with Degree” option from the Radical pulldown). If typing roots 

manually, remember that √𝑥 + 1
5

 can instead be written as (𝑥 + 1)
1

5, etc. 



S 

Secant function: sec followed by spacebar, followed by the content you want to type within the function (remember 

parentheses if needed), followed by the right arrow to exit the secant function to type more math content. 

Set of integers symbol: \doubleZ, where the Z within the command is a capital letter. 

Set of natural numbers symbol: \doubleN, where the N within the command is a capital letter. 

Set of rational numbers symbol: \doubleQ, where the Q within the command is a capital letter. 

Set of real numbers symbol: \doubleR, where the R within the command is a capital letter. 

sigma (lowercase): \sigma followed by spacebar, produces the output 𝜎. 

Sigma (uppercase): \Sigma followed by spacebar, produces the output Σ. If you want to use the summation symbol, 

see Summation. 

Similarity symbol: \sim followed by spacebar 

Sine function: sin followed by spacebar, followed by the content you want to type within the function (remember 

parentheses if needed), followed by the right arrow to exit the sine function to type more math content. 

Square root: type \sqrt followed by spacebar, followed by the content that you want included inside the square 

root, followed by spacebar. 

• To obtain √𝑥 , type \sqrt followed by spacebar followed by x. 

• To obtain √𝑥 + 5 , where you want the x + 5 inside the square root, you must use parentheses. Type \sqrt 

followed by spacebar, followed by (x+5), followed by spacebar. 

• To obtain √𝑥 + 5 + 3, where you want the x and the 5 inside the square root and the + 3 outside the square 

root: type \sqrt followed by spacebar, followed by (x+5), followed by spacebar, followed by +3. 

Subscripts: Use the underscore key, followed by the desired subscript, so 𝑥1 is typed as x_1, followed by either the 

spacebar or additional math content, and 3𝑛+1 is typed as 3_(n+1), followed by either the spacebar or additional 

math content.  

Summation (capital Sigma): To type ∑ (𝑛2 + 1)5
𝑛=1  , type \sum_(n=1)^5 (n^2 +1). If you type the math content on a 

line by itself it will appear larger, as shown below: 

∑(𝑛2 + 1)

5

𝑛=1

 

Superscripts: See Exponents 

T 

Tangent function: tan followed by spacebar, followed by the content you want to type within the function 

(remember parentheses if needed), followed by the right arrow to exit the tangent function to type more math 

content. 

Therefore symbol: \therefore followed by spacebar 

theta (lowercase): \theta followed by spacebar 

Triangle symbol: The triangle symbol is not easily  

U 

Union symbol: \cup followed by spacebar 



Discovering other equation tool commands 

The list above is not exhaustive. Here are two methods you can use to discover additional keystroke commands for 

Word’s equation tool. (The second method will be much easier for sighted users.) 

1. Many of the commands in the list are the same as those that would be typed when using a mathematical 

typesetting system known as LaTeX. If there is a symbol that you want to create which is not included on this 

list, do an online search for the word LaTeX and the name of that symbol, and then try that LaTeX command or 

the backslash symbol followed by that command within Word’s equation tool. (This does not work for every 

command but works for many of them.) Also realize that many math commands require you to press spacebar 

after the command for the symbol/function to show up properly and to be read properly by JAWS screen 

reader. 

2. If you are able to navigate Word’s equation toolbar, go to the Symbols menu and hover over any one of the 

symbols. When you do so, you will notice that a box appears with the name of the symbol – and if manual 

keystrokes can be used to replicate that symbol, they are listed in parentheses after the symbol name. The 

screenshot below shows that if you hover over the cube root symbol, a box appears which says, “Cube root 

(\cbrt).” This means that if you want the cube root symbol to appear with manual keystrokes, you should type 

\cbrt; remember to follow this command with the spacebar. 

 

Also notice that on the right side of the Symbols menu, there is a downward arrow which serves as a pulldown 

to find additional math symbols. 

Just below that downward arrow, there is a double downward arrow which allows you to access addtitionl 

categories of symols. . Th e 

 

 

  

Type equation here. 

Troubleshooting 

If the commands in this document are not working for you, try each of the steps below (one at a time) to see if the 

problem is resolved. 

1. Go to the File menu, select Options, then Proofing, then navigate to the button that says AutoCorrect Options, 

then choose the tab that says Math AutoCorrect. Make sure that the checkbox “Replace text as you type” is 

checked. (This checkbox should be checked by default and would likely only be disabled if you chose to disable 

it.) 

2. Navigate to the Insert Menu, choose Equation, navigate to the Conversions group and make sure that the Inline 

checkbox is chosen (rather than LaTeX or Text). 



Adding Content to this List 

The above list is intended to cover common symbols and functions needed for mathematics and science courses. 

Contact Jennifer Marsala at jmarsala@central.uh.edu to request additional content to be added to this list. 

mailto:jmarsala@central.uh.edu

	Contents
	Introduction
	Opening Microsoft Word’s native equation tool
	Typing math content using the toolbar (sighted users)
	Exiting the equation tool
	Keystrokes for common math symbols and functions (Jump to list of keystrokes.)
	List of keystrokes and commands, in alphabetical order
	A
	B
	C
	D
	E
	F
	G
	H
	I
	K
	L
	M
	N
	O
	P
	R
	S
	T
	U


	Discovering other equation tool commands
	Troubleshooting
	Adding Content to this List

